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1.

TR

FFRIR: GD32 MCUF AR

Pk Es: J-Link VO/V108GD-Link

E &% : WINT 64-bit OS

IDE: eclipse-embedcpp-2021-03-R-win32-x86_64

X 5. xpack-arm-none-eabi-gcc-10.2.1-1.1-win32-x64

g% L E: gnu-mcu-eclipse-windows-build-tools-2.12-20190422-1053-win64
GDBJR%#%: OpenOCD / J-Link GDB Server CL V7.54b
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2. ITEFXR

2.1. HETE

T Eclipse, LAUCH eclipse-workspace. 7t “File->New” | AJ £ #%# # C/C++ Project, #£#%
C Managed Build.

& 2-1. & ARM C I12

S eclipse-workspace - Eclipse IDE
File | Edit Source Refactor MNavigate Search Project Run Window Help

New Alt+Shift+M b | & Makefile Project with Existing Code
Open File... T C/C++ Project |

[} Open Projects from File System... Project...

B P 'IJ Y o g [ Create a new C or C++ project ]
3 ”
Recent Files Convert to a C/C++ Autotools Project
Close Editor Ctrl+W Convert to a C/C++ Project (Adds C/C++ Natu
Close All Editors Cirl+5hift+W | 8% Source Folder
Save Ctrl+S [ Folder
. ¢ Source File
Save As... '—<‘> .
Save Al Ctrl+Shift+s | ] Header File
= =
Revert | File from Template
& Class
Move...
Rename... F2 w | R
#7 Refresh F5 [ Other.

Convert Line Delimiters To »
Print... Ctrl+P

= Import..

5 Export.
Properties Alt+Enter
Switch Workspace 3
Restart
Exit L Tl =1 1 Fn -
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2-2. i%&¥ C Managed Build

= Mew C/C++ Project =] G

Templates for Mew C/C++ Project

_ C Managed Build =
ChMake @" A C Project build using the COT's managed build

Make system.

Mesan

m

g C++ Managed Build
\‘C':' A C++ Project build using the COT's managed build

sysfer.

CMake Project 4
A CMalke project with a Hello World executable to get
started.

Empty or Existing CMake Project
Create a CMalke project with no files. Can be used fo
create one over existing content.

1| 1] : | 3

® = Back Next = Finish

i\ Projectname, FLE THERM, AT T UCH THEME] FW HX T . 4irdEits 8 ARM
Cross GCC.
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2-3. #E ARM TREBMZEFETIEFHBEE

[

C Project

1, Directory with specified name already exists.

Project name: Project

[] Use default location

Location: Fieclipse-workspace\GD32F10x_Firmware_Library_V2.2.1\Template\Eclipse_project

Choaose file system: |default -

Project type:

Toolchains:

> = GNU Autotools
4 = Executable

lﬂ Empty Project l
Hello World ANSI C Project
Helle World Arm C Project
Helle World RISC-V C Project
ADUCM36x CfC++ Project

®

Freescale Kinetis Klxx C/C++ Project

SiFive RISC-V C/C++ Project

STM32F0xx C/C++ Project

STM32F1xx C/C++ Project

STM32F2xx C/C++ Project

STM32F3xx C/C++ Project

STM32Fdxx C/C++ Project
® STM32F7xx C/C++ Project

> = Shared Library

> = Static Library

> = Makefile project

® & @ ® 000 e @@

Hello World Arm Cortex-M C/C++ Project
Freescale Processor Expert C/C++ Project

l Arm Cross GCC ]

Cross GCC
MinGW GCC
RISC-V Cross GCC

Show project types and toolchains only if they are supported on the platform

= Back ”I Mext =

Finish

#Eclipse IDECL IEHi1% & T ARM Toolchains Path, X HL¥ 2> H 3k %1%, & Eclipse IDEA
W EARM Toolchains Path, tHA]{EiX H ik £ 2]ARM Toolchains4 % ¥ 1% .

10
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[

GMNU Arm Cross Toolchain

Select the toolchain and configure path

Toolchain name: *xPack GNU Arm Embedded GCC (arm-none-eabi-gec)

-

ITc-oIchainpath: ${eclipse_homePeclipse_toolchain\xpack-arm-none-eabi-gece-10.2.1-1.1\bin ] lBrcmtse...l

':?:' Next = [ Finish ] [ Cancel

AidiFinish”, E 2SR A &R-5. LA ~. ik, 5¢HProjectfIE 7,
& 2-5. THEUE

= eclipse-workspace - Eclipse IDE

=T )
File Edit Source Refactor Navigate Search Project Run Window Help
i & - |-G @ BT~ H-0-C- G- @O 5~ Bidgin|L

LR Ry b Q s
EProje. 2 = 8B = B8 fFox @B b = O

SR e §

4[i=5 Project (in Eclipse_y There is no active editor that

a il Includes provides an outline.

@ Eifeclipsefecli

> (B Eifeclipsefecli
s (= Exfeclipsefecli

2! Problems &3 ¥ Tasks B Console [ Properties 7 § =0
0 items
Description = Resource Path Location Type

<4 [m 2

&5 Project

|

2.2. BrEg TR AR IE A

221, FIHRE LT RB A

A LFES, %E#FEnew->Folder.,
11



€

GigaDevice

GD32 ARM

ANO041
MCU Windows £4: | Eclipse J & #f%

B 2-6. FELESCMHR

4[5 Proje——=——"
- MNew r [ % Project.
4 il In
X @ Go Into % Fle
=) Open in New Window “File from Template
B | shown Al shifesw > |29 Folder
Show in Local Terminal » G Class
Copy Ctrl+C | [5] Header File
Paste Ctrl+V f Source File
Delete Delete | % Source Folder
Source "I c/ct+ Project
Moves Convert to a C/C++ Project (Adds CfC++ Mature]
Rename... F2
™ Example...
Import...
= L el o B
LA A Peripherals .
5 YN
2-7. B BHLF R
—nal=l

= New Folder

Folder

Project

Create a new folder resource.

Enter or select the parent folder:

+ == Project

[ Folder name: Peripherals

) = Use default location

l @ [ Folder is not located in the file system (Virtual Folder) l

() (@ Link to alternate location (Linked Folder)

default

Resource Filters...

Browse... Variables...

Cancel ]

Finish | |

[A) £ 773278 37 Application. CMSIS. Doc. Ld. StartupflUtilitiesSC 3% .

12
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& 2-8. ARM TN HE

= eclipse-workspace - Eclipse IDE

File Edit Source Refactor MNavigate Sea

ﬁ - | @ - % - .I]-I{l iﬁ - Elﬁ L

e - - t } - - | .

5 Project Explorer &2 = O
=R

4% Project (in Eclipse_project)

4 5l Includes
- ([& E:feclipse/eclipse_toolchain/xpa
- (=l E:feclipse/eclipse_toolchain/xpa
- ([& E:feclipse/eclipse_toolchain/xpa

- iy Application

. G CMSIS

» oy Doc

» 7y Ld

: iy Peripherals

» [opy Startup
- gy Utilities

FiiiApplication, & Importi& i, H SN,

13
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& 2-9. RmsciE

2= Project (in Eclipse_project)
4 [l Includes
- (5! E:feclipse/eclipse_toolchain/xpa
- ([=! E:feclipse/eclipse_toolchain/xpa
; eclipse_toalchain/xpa

Applic=
Cr Appli . X

- G CMSIS
» oy Doc
g Ld Cpen in New Window

" (&g, Periph St In Alt+Shift+ W »
B Startu

. G Utilitie

Go Into

Show in Local Terminal 3

2 Copy Cirl+C
Paste Ctrl+W

K Delete Delete
Source r
Maowve...

Fename... F2

ﬂ g Import.. l Import |

B Exp::urt...

Build Project
Refresh F3

Importifi#¥File System. £ L F AR HAE, AERTESAN .

14
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A 2-10. #EFE Import SCHF

= Import i
[ Project Explorer &2
s =5 Project (in Eclipse_prg| | Import resources from the local file system into an existing project. H

4 5l Includes
> (= Eifeclipse/eclipst
» (£ Eifeclipsefeclipst

> (1= Eifeclipse/eclips *

& Application 4 (= General it
F [ CV & Archive File

Select an import wizard:

> 2 Doc “ Existing Projects into Workspace E
e
> (73 Peripherals |l Preferences b
> [y Startup [} Projects from Folder or Archive
> B Utilities = CfC++
> = Git
=, Tnctall =

@ = Back MNext = Finish

15
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& 2-11. Import Application SC{t3 Py 3Tt

= Import L [ S
File system ()
Import resources from the local file system. ‘if_/A

IFrom directory: F:}ecliese—workseace:GDﬂFle Firmware_Library \.I'2.2.lkExamples\GPlO\Rgnninq led vl[ Browse... ]

6] gd32f10x_it.c
[71 [ gd3zf1oxith

L lc| gd32fiox libopth
main.c

1 [l main.h

[ 2l readme.txt

o] systick.c
[T Tél evetick.h

[ Running_led

| »

m

Filter Types... l [ Select All l l Deselect All
Into folder: Project/Application
Cptions

[] Overwrite existing resources without warning

[7] Create top-level folder

Create links in workspace
Create virtual folders

Create link locations relative to: | PROJECT_LOC -

® Next = [ Finish ] ’ Cancel

M3, ¥ S ACMSIS. Doc. Ld. Peripherals. Startup/%Utilities S {43% .

16
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& 2-12. Import CMSIS 3C#:32 3044

‘= Import e =T |
File system ==
Import resources from the local file system. L’f KA

IFrom directory: F\eclipse-workspace\GD32F10x_Firmware_Library V2.2.1\Firmware\CMSIS\GD\GD32F10x\Source  ~ I Browse...

> [@] = Source

[£] system_gd32f10x.c ‘

[Filter Types... ] I Select All ] I Deselect All

Into folder: Project/CMSIS

Options
[T] Overwrite existing resources without warning

[[] Create top-level folder

== Advanced

Create links in workspace
Create virtual folders

Create link locations relative to: | PROJECT_LOC -

Browse...

® MNext = [ Finish ] [ Cancel
& 2-13. Import Doc X434
&= Import [ = [ S|
File system i
Import resources from the local file system. L’f ;’A
From directory: F\eclipse-workspace\GD32F10x_Firmware_Library V2.2.1\Examples\GPIO\Running_led Browse... ]
(= Running_led [C] [ gd32f10xith -
[C] [ gd32f10x libopt.h r
[ [E mainc ‘E
[ [g] rmainh 4
. readme.txt
1 [l custick.c S

Filter Types... ] ’ Select All l [ Deselect All

Into folder: Project/Doc

Options
[T Overwrite existing resources without warning

[7] Create top-level folder

<= Advanced

Browse...

Create links in workspace
Create virtual folders

Create link locations relative to: | PROJECT_LOC -

Cancel

Next = [ Finish ] [

17
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& 2-14. Import Ld 324 3% 30 4

l= Import

=

File system

Impaort resources from the local file system.

*; =—1

N

lFrom directory: Fleclipse-workspace\GD32F10x_Firmware_Library_V2.2.1\Firmware\CMSIS\GD\GD 32F10x\Source\GCC v” Browse... ]

Into folder: Project/Ld

Options

[[] Create top-level folder

[] Overwrite existing resources without warning

Create links in workspace
Create virtual folders

Create link locations relative to: |PROJECT_LOC -

™
(= GCC | gd32f10x flash.ld =
[T] [5) startup_gd32f10x_cl.$ 1
[T [§) startup_gd32f10x_hd.S 1
[T] [3) startup_gd32f10x_md.5 il
[T @ comubiin AWM A © o
Filter Types... ] ’ Select All ] ’ Deselect All

Finish ] ’ Cancel

18
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& 2-15. Import Peripherals (44323044

< Import T )
File system 1
Import resources from the local file system. Lf S/

(N

IFrom directory: A\eclipse-warkspace\GD32F10x_Firmware_Library V2.2.1\Firmware\GD32F10x_standard_peripheral\Source ~ I Browse... ]

(= Source

[+

g gd32f10x_adc.c
[€] gd32f10x_bkp.c
[€] gd32f10x_can.c

[g gd32f10x_cre.c

[ gd32f10x dac.c
[€] gd32f10x_dbg.c
[£] gd32f10x_dma.c
(¢l ad32f10x enet.c

»

m

Filter Types... Select All Deselect All

Into folder: Project/Peripherals

Options
|| Overwrite existing resources without warning

[] Create top-level folder

<= Advanced

Create links in workspace
Create virtual folders

Create link locations relative to: |PROJECT_LOC -

MNext =

Browse...

Finish

J{

Cancel

19
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& 2-16. Import Startup 304332 /8

% Import =RE=EC x|
File system e
Impaort resources from the local file system. LX_/A

l:rom directory: \eclipse-workspace\GD32F10x_Firmware_Library V2.2.1\Firmware\CMSIS\GD\GD32F10:\Source\GCC v]’ Browse... ]

»

= GCC [7] 7] gd32f10x_flash.ld
startup_gd32f10x_cl.§
[T [§) startup_gd32f10x_hd.S
[T] [$] startup_gd32f10x_md.5 =

m

[T [8) startup_gd32f10x_xd.5 -
Filter Types... ] [ Select All ] [ Deselect All
Into folder: Project/Startup
Options

[[] Overwrite existing resources without warning

[[] Create top-level folder

|| Create links in workspace
Create virtual folders

Create link locations relative to: |[PROJECT_LOC -

@j’ = Back Mext = Finish ] [ Cancel

20
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& 2-17. Import Utilities Cf4:32 3044

[= Import

File system

Import resources from the local file system.

o

-l

From directory: F\eclipse-workspace\GD32F10x_Firmware_Library V2.2.1\Utllities

Browse...

» [H (= Utilities 6] gd32f10x_eval.c
["] 8] gd32f10x_eval.h
[ [g gd32f10x_led_eval.c
[C] [£] gd32f10x_led_eval.h

Filter Types... ] l Select All ] l Deselect All ]

Into folder: Project/Utilities

Options
[T Overwrite existing resources without warning

[[] Create top-level folder

== Advanced

Create links in workspace
Create virtual folders

Create link locations relative to: | PRCOJECT_LOC -

Browse...

@ MNext = [ Finish

Cancel

21
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& 2-18. &% ARM TEMLE

-i eclipse-workspace - Project/Application/main.c - Eclipse IDE

T B, |

File Edit Source Refactor Navigate Search Project Run Window Help
il B~ R -G - @ - E B O L BB < B Bi%iw|&id- §
I§5 Project Explorer E3 = B  [€ mainc 2 = 0
= <‘=:=D '\l_f' § 28 WARRANTIES OF MERCHANTABILITY AND FITHESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. -
P 29 IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONMTRIBUTORS BE L ANY DIRECT,

4 1% Project (in Eclipse_project)

2.2.2.

4 Utilities
> [ gd32f10x_eval.c
4| 1 |

3@ INDI T, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL INCLUDING, BUT
A@]J]ndudes 31 NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVI USE, DATA, DR
» (B Eecipsefeclipse_toolchain] | 32 PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY TH BILITY],
@ Eech i y Ichai 33 WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING MEGLI E OR OTHERWISE)
g /eclipsefeclipse_toolchain/ 34 ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILT
> @ E:ifeclipse/eclipse_toolchainy| 35 OF SUCH DAMAGE.
4 ¢y Application ;g =/
> lgh gd32f10x ite (235 #include "zd32flex.h”
> [ main.c [2/39 #include "gd32fléx_eval.h”
> [y systick.c 48 #include "systick.h"
41 #include <stdic.h>
G CMSIS 22
4y Doc 430 f*] F
[ readme.txt L main function
d 45 ram[in] none
] 46 ram[out] none
T gd32f10x flash.ld 47 al none
4 (3, Peripherals 48
49= int main(void)
> [ gd32f10x_adcc se {
> |6 gd32f10x_bkp.c 51 systick_config();
> [§ gd32f10x_can.c 52 gd_eval led_init(LEDZ);
- 53 gd_eval led init(LED3);
> & gd32f10x crecc sa gd_eval led init(LEDa); E
> [gh gd32fl0x_dacc 55 gd_eval led_init{LED5);
> [ gd32f10x_dbg.c E =L
57 while(1){
> | gd32f10x dma.c 58 /* turn on led2, turn off leds */
> [ gd32fl0x_enet.c 59 gd_eval_led_on(LEDZ);
5 @ gd32f10x_exme.c 68 gd_eval led off(LED5);
. 61 delay_ims(1868);
g @ gd32f10x extic 62 /* turn on led3, turn off led2 */
> [ gd32f10x_fmec.c 53 gd_eval led on(LED3);
[ gd32f10x fwdgt.c 64 gd_eval led off(LED2);
T 65 delay_1ims(1880); m
> 8 gd32f10x gpio.c 66 /* turn on led4, turn off led3 */
> [ gd32flix i2ec 67 gd_eval led on(LED4);
> @ gd32f10x_misc.c 68 gd_eval led off(LED3);
69 del Ims(188a); -
> [ gd32f10x_pmu.c o elay_ins( ) = | 5
> | gd32f10x_reuc
> @ gd32f10x_rtc.c I:_ Problems 52 = Tasks & Consale [ Properties
> @ gd32f10x_sdio.c 0 items
> [ gd32f10x_spi.c Description Resource Path Location Type
> [ gd32f10x_timer.c
> [§ gd32f10x_usart.c
> [ gd32f10x wwdgt.c
4 [, Startup
> [§) startup_gd32f10x_cl.5

“Refresh” J7sUE MU KA NSO

B bR T B AR IR ST AR J T N SCA () 7 2k, AT DA 7R R N B SO IE R SO N B
BEE 5 #5710 .cproject [F] 24 (K U4 96 N« fEEclipse IDEH, A LFE4, Jfik#FRefresh, HJ
AL SO e KOS A N AR
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B 2-19. T4

=T

| .settings
. Debug
. gd_libs
| inc
) Idscripts
| srC
|=| .cproject
=] .project

| | readme.tt

& 2-20. Refresh .72

il | &2 %iw | BN R R
75 Project Explorer i3 BES Y § = O B
& gd32f10 :
e - Mew r
4 [ Project |
o Go Into
* 5%, Binari
> [ Inclug Open in New Window
) Applic Show In Alt+Shife+W »
> ey CMSI Show in Local Terminal ]
> 2= Debu
. & Doc [5 Copy Ctrl+C
&y Ld Paste Ctrl+V
» Ey newlilf 3 Delete Delete
» &gy Periph Source 3
[y Starty Move...
» (2 Utilitie Rename.. £2
» =% Project_F
g Import.
iy Export.
Build Project
Clean Project
_ E
Close Project
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& 2-21. Eclipse IDE § THEZ5#)

File Edit Source Refactor Mavigate Search Project Ry
il EEHEE Y
55 Project Explorer 2 5% Y § T 0
4|5 gd32f10x_example

.34 Binaries

* [a) Includes

» = Debug

> = gd_libs

> f= Inc

> = |dscripts

» =% SFC

=| readme.txt

HR: “Refresh” 75 LSO RSO, 2 JSEAEER), JF H— B {EEclipse IDEH
HARRIEA S, 2SR E DR PR T

2.3. TERE

Fih TR, &5 TR JE M Propertiesit 4T 7T
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2.3.1.

A 2-22. TEREEE

4|5 Project (in Eclipse_project)

a i Incl MNew
> (= B Go Into
- (2 E
= e Open in New Window
4 Gp App Show In
d Show in Local Terminal
=
SR copy
g @ 3 Paste
> Ch
En ¥ Delete
4 g Dod
__ Source
Ely
4y Ld Mowve...
d Rename...
“ ri g  Import..
’ ey Export.

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Project

Alt+Shift+W

Ctrl+C
Ctrl+V

Delete

F2

F5

3

3

3

Build Targets

Index

Build Configurations

Profiling Tools
Run As

Debug As
Profile As

# 0

Restore from Local History...
Run C/C++ Code Analysis
Team

Compare With

Validate

%

&

¥ TN T (TN Vi O WO (TN O T (T U O (W (O B (T (Y B (T Y WO (O (O B [

Configure

2 BPPEEEPPEEEEPE PR PEE p

o

Source

= Properties
itkes J

g -

»

Alt+Enter

[Open Properties Dialog ]
3

3

ol =

Target Processor it B

7£“C/C++ Build->Settings->Tool Settings->Target Processor” N & &l :

AR EH ARG K N, %3Fcortex-m3. cortex-m4. cortex-m238icortex-m33. TEAfH, %k

Fcortex-m3.
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& 2-23. Target Processor EC B

€

GigaDevice

= Properties for Project - R [ [ T
type filter text Settings - ~ 8
> Resource i
Builders - i
4 C/C++ Build Configuration: ’Debug [ Active ] v] lManage Conﬁguralions...]
Buid Variables
Environment
; ool Settings oolchains | [ Devices ontainer Settings uild Steps
Logging ® Tool Settings | i Toolchains | i D 0c 5  Build § EE
Tool hain Editor I (= Target Processor I Arm family (-mcpu) cortex-m3 I
# Optimization
s CJC++ General g Warnings Architecture (-march) |Toolchain default
Linux Tools Path = ; .
MCU (£ Debugging Instruction set IThumb (-rthumb)
[»
s . .
Project Natures 4 iNU Arm Cross Assembler [ Thumb interwork (-mthumb-interwark)
’ (#2 Preprocessor
;roj:;t :efe;encles & Includes Endianness lToolchain default
un/Debug Settings v . . - L
Tack Repasito (2 Warnings Float ABI Toolchain default E
L P v (2 Miscellaneous
Tasl Tégs 4 B GNU Arm Cross C Compiler FPU Type realdia dleEi
> Validation (% Preprocessor Unaligned IT lehainsdefaul
WikiText naligned access oolchain default
2 Includes
¥ Optimization [ TrustZone (-mcmse)
VP
(2 Warnings Adrchbd family Generic (-mcpu=generic)
B3 M - -
(2 Miscellaneous Feature crc Toolchain default
4 5 GNU Arm Cross C Linker
(B General Feature crypto Toolchain default
(2 Libraries Feature fp Toolchain default
2 Miscellaneous
4 % GNU Arm Cross Create Flash Image Feature simd Enabled (+simd)
L] E
(£ General Code madel Small (-memodel=small)
4[5 GNU Arm Cross Print Size ot ol o
trict align (-mstrict-align)
#2 General
Other target flags
< T | » =2
® [Apply and Close] [ Cancel

2.3.2. Optimization At &

7£“C/C++ Build->Settings->Tool Settings->Optimization” & i 1 it & 4k 45 4%, 7] 31%-00. -O1.
-02, -03. -Os. -Ofast. -Og.
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& 2-24. Optimization it B
= Properties for Project l = éj

type filter text Settings T T8

> Resource
Builders - m
Caonfiguration: [Debug [ Active ] vl [Manage Configurations...
Build Variables

Environment

3 Tool Settings | B3 Toolchains | {8 De'\.ricesl @ Container Settings | 4 Build Steps | IR

| ogging
Settings
. Target Processor Optimization Level Optimize size (-Os)
ool Chain Editor =

» C/C++ General Defimizaion [¥[Message length [-fmessage-length=0)

Linux Tools Path o \ [¥]'char' is signed (-fsigned-char)
(# Debugging . ) . .
> MCU [¥] Function sections (-ffunction-sections)

4 3 GNU Arm Cross Assembler
(2 Preprocessor [¥] Data sections (-fdata-sections)

(2 Includes [[INo common unitialized (-fno-common)

Warnings

Project Natures

m

Project References
Run/Debug Settings
Task Repository
Task Tags

> Validation
WikiText

(# Warnings [T] Do not inline functions (-fna-inline-functions)

2 Miscellaneous [[] Assume freestanding environment (-ffreestandin
4 By GNU Arm Cross C Compiler 7] Disable builtin (-fno-builtin)

(2 Preprocessor

(2 Includes

(# Optimization

2 Warnings

2 Miscellaneous
4 GNU Arm Cross C Linker Other optimization flags

# General

# Libraries

[[]single precision constants (-fsingle-precision-co
[[] Position independent code (-fPIC)
[[] Link-time optimizer (-flto)

[ Disable loop invariant move (-fno-move-loop-in

# Miscellaneous

4 By GNU Arm Cross Create Flash Image
# General

4 By GNU Arm Cross Print Size
# General

@' [»\3\pp|},r and Close] ’ Cancel

2.3.3. GNU Arm Cross C Compiler it &

7£“C/C++ Build->Settings->Tool Settings->GNU Arm Cross C Compiler’i% i #fic & Cross C
O PRI T

Al i, 7E “Preprocessor->Defined symbols” i% Tl #1 ¥ it USE_STDPERIPH_DRIVER FI
GD32F10X_CL¥i4mi¥ % .
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& 2-25. GNU Arm Cross C Compiler -> Preprocessor Bt &

= Properties for Project S S - — - - - B | S
type filter text Settings - v §
> Resource i
2ilde =
4 C/C++ Build Configuration: lDebug [ Active ] v] lManage Conﬁguralions...]

Build Variables

Environment -
Logging B3 Tool Settings | 3 Toolchains | [ 1 De'vicesl [0 Container Settings | # Build Slepsl 3]
Settings

(3 Target Processor [[1Do not search system directories (-nostdinc)

Tool Chain Editor @ Optimization [[]Preprocess only (-E)
> C/C++ General s .
(£ Warnings

Linux Tools Path (8 Debugging
SERIP STVER
> Mcu 4 [ GNU Arm Cross Assembler
GD32F10X_CL

(5 Preprocessor
(2 Includes
(2 Warnings
(2 Miscellaneous

88 8 il &

Project Natures

Project References
Run/Debug Settings
Task Repository

Task Tags a B GNU A Cro Compiler

> Validation

WikiText (% Includes

m

(# Optimization
(# Warnings
(& Miscellaneous

4 [ GNU Arm Cross C Linker
(2 General
(2 Libraries
(2 Miscellaneous

4 [ GNU Arm Cross Create Flash Image
% General

4 3 GNU Arm Cross Print Size
% General

Undefined symbols (-U) &

! [Apply and Close] I Cancel

7E"includes->Include paths”iE I ¥ Il TAREFT 5 13k SO 848 ZEA BN :
"${ProjDirPath}/../../[Firmware/CMSIS/GD/GD32F10x/Include"
"${ProjDirPath}/../../[Firmware/CMSIS"
"${ProjDirPath}/../../IFirmware/GD32F10x_standard_peripheral/Include"
"${ProjDirPath}/../../Template"

"${ProjDirPath}/../../Utilities"

R ARG AN S SO B AR AR BR AR . X HL AT DA BRI 4 0] B8 42
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& 2-26. GNU Arm Cross C Compiler -> Includes Bt &
Is Properties for Project L@g

type filter text Settings - v 3
» Resource ~
Builders - bl

la C/C++ Build Configuration: ’DEbUQ [ Active ] '] lManage Conﬂgurations..‘l

Build Variables

Environment
coaing & Tool Settings | ) Toolchains | f & Da'vicesl 0 cContainer Seﬂingsl 4 Build Stepsl Build Artifactl Binz ' | "
Toaol Chain Editor
» CfC++ General
Linux Tools Path

(% Target Processor Include paths (-I) & 8 &
# Optimization
2 Warnings

“${Proj 1} eof /C|
'${ProJD|rPath),-‘ Firmware/CMSIS"

. MCU (£ Debugging "${ProjDirPath}/../../Firmware/GD32F10x_standard_peripheral/Include”
. 4 B GNU Arm Cross Assembler "${ProjDirPath}/../../ Template"
Project Natures (5 Preprocessar *§(ProjDirPath/. /.. Utilities” =
Project References ™
(& Includes

Run/Debug Settings
Task Repository
Task Tags

» Validation

(& Warnings
& Miscellaneous
4 55 GNU Arm Cross C Compiler

# Preprocessor Include system paths (-isystem) &

WikiText @ Includes

@ Warnings
& Miscellaneous

4 B85 GNU Arm Cross C Linker
(& General

2 Libraries
& Miscellaneous
4 B GNU Arm Cross Create Flash Image

& General Include files (-include) L=
4 B3 GNU Arm Cross Print Size
(& General ‘ ‘ S
f,’\
(;/ Apply and C\ose] [ Cancel I

2.3.4. GNU Arm Cross C Linker it B

{£“C/C++ Build->Settings->Tool Settings->GNU Arm Cross C Linker’[it & Cross CH#:%£T
7£“General ->Script files” ¥ 1 s i -
"${ProjDirPath}/../../Firmware/CMSIS/GD/GD32F 10x/Source/GCC/gd32f10x_flash.ld"

IdA A7 55 RBEREBY . 9n PR SEII AT BT SO AT i B N A FH AONdBELAS BAZ AR & B bRl
FrHIFLASH X SRAM KN K & BT R N AE T &

R ARG AN BRI B AR . X BL W] DLEL IR I Z6 0 BR AR
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& 2-27. GNU Arm Cross C Linker -> General it E

‘= Properties for Project — [ o )
type filter text Settings - ~ 8
» Resource Configuration: {Dabug [ Active ] 'J IManage Cnnﬁgurations..‘l B
Builders

IA C/C++ Build I
Build Variables

Enviranment

i Tool Settings ‘ 1525] Too\:hainsl B Devicesl [ Container Seﬂingsl # Build Steps Build Artifact

Binary Parsers ' | *

Logging (% Target Processor Script files (-T) LEE =R =R
-Seﬂins B irnizati
ﬂ‘ ) = Opt‘”’f'zat"’” *${PrajDirPath}y/../../Firmware/CMSIS/GD/GD32F10x/Source/GLC/gd32f10x_flash.
Tool Chain Editor # Warnings
» CfC++ General

(22 Debugging
Linux Tools Path 4 i3 GNU Arm Cross Assembler

» MCU (2 Preprocessor

Project Natures (2 Includes

m

Project References (22 Warnings
Run/Debug Settings (2 Miscellaneous

Task Repository 4 53 GNU Arm Cross C Compiler

Task Tags
> Validation

WikiText

(% Preprocessor
(2 Includes
(% Optimization
(2 Warnings
(2 Miscellaneous
4 B3 GNU Arm Cross C Linker

ibraries
(2 Miscellaneous

4 B3 GNU Arm Cross Create Flash Image
(2 General

4 B3 GNU Arm Cross Print Size
(2 General

< 1 ] »

®

< 1 ] »

[Apply and Close] [ Cancel ]

7EMiscellaneousit i, “aikUse newlib-nano/2Do not use syscalls. (A4S AN
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2.3.5.

K] 2-28. GNU Arm Cross C Linker -> Miscellaneous Bl &

‘= Properties for Project

type filter text
> Resource
Builders
C/C++ Build
Build Variables

Environment

| ogging
#-Seﬁings
ool Chain Editor

> C/C++ General
Linux Tools Path
> MCU
Project Matures

Project References
Run/Debug Settings
Task Repository
Task Tags

> Validation
WikiText

4| i | »

@

Settings

Configuration: lDebug [ Active ]

'] l Manage Configurations...

® Tool Settings | 5% Toolchains | ‘N Devicesl 0 Container Settings | # Build Stepsl

Buil| * | *

@ Target Processor
(2 Optimization
%2 Warnings
(%2 Debugging
4 B3 GNU Arm Cross Assembler
@ Preprocessor
(# Includes
(22 Warnings
(% Miscellaneous
4 B3 GNU Arm Cross C Compiler
(% Preprocessor
(# Includes
(2 Optimization
(2 Warnings
(#2 Miscellaneous
4 B3 GNU Arm Cross C Linker
(# General
Libraries

22 General
4 B GNU Arm Cross Print Size
(# General

eate Flash Image

Linker flags (-Xlinker [option]) &

Other objects £

Generate map "${BuildArtifactFileBaseName}.n

[ Cross reference (-Xlinker --cref)

[“] Print link map (-Xlinker --print-rmap)

[¥] Use newlib-nano (--specs=nano.specs) l

Use float with nano scanf (-u_scanf float
[ Do not use syscalls (--specs=nosys.specs)

["JUse float with nano printf (-u _printf_float)

E\ferbose (-v)
Other linker flags

4| 1 | 3

[Restore De‘faults] [ Apply ]

[Apply and Closel l Cancel l

Build Steps i & -4 5% bin 304

{E“C/C++ Build->Settings-> Build Steps”a] s Ill#r 4, A= mbin/hex3C 14 .

A EIN: arm-none-eabi-objcopy -O binary "Project.elf"
objdump -D "Project.elf" >

"Project.dump"

"Project.bin"; arm-none-eabi-
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& 2-29. Build Steps L&
[=TPropertics Tor Project I o=

type filter text Settings =12 -~ 8

» Resource

4 C/C++ Build Configuration: [Debug [ Active ] v] [Mﬁnage Conﬁgurations”.]
Build Vanables

Environment

..... J# Build Steps ‘ Build Arlifacll Binary Parsers | @ Error Parsers ] [
Pre-build steps 1
ain Editor
Command:

» CfC++ General
Linux Taols Path
> MCU Description:
Project Natures

Project References

Run/Debug Settings Post-build steps
Task Repository Command:
Task Tags arm-none-eabi-objcopy -O binary "Project.elf® "Project.bin”; arm-none-eabi-objdump -D "Project.elf® = "Project.dump” §~
» Validation
WikiText Description:
-
@ [App\y and Close] [ Cancel

2.4, YRk L2

% $Project->Build Project ] % 1% 24 7 T/
R Build Project/& 4% 24/ T2, Build All/Z %1% 2 Fiworkspacefii i Tz

2-30. Build T2

- w i

= eclipse-workspace - Project/Application/main.c - Eclipse IDE

File Edit Source Refactor Mavigate Search [Prcject] Run Window Help

il | WK~ B % \Q| Open Project - @~
7 - - F o - | = Close Project
5 Project Explorer 22 [H S 7 8 = O | [ Build All Ctrl+B
4/1:% Project (in Eclipse_project) Build Configurations 3
dC ]ncluFiesl L__Build Project_[f i1 Project
> gy Application Build Working S&t »
>y CMSIS Clean
D - -
” e Doc Build Automatically
> Gy Ld
» ¢y Peripherals Build Targets 3
| |
’ (e Startup C/C++ Index 8
» 7 Utilities
Properties
| oo rmwerarrew T LedS
gd eval led on(LED2Z);
gd eval led off(LEDS);
| delay 1ms(1888);

VER: BERGR1R 200 75 S R A7 2400 TR 1, & W49 B2 b — IR IR . BXUR N T #ifk
TE#h,35 5clean T.5% /5 Fbuild .

miEse e, BB T M elf. hex & binSCf4:.
32



GigaDevice

ANO041
GD32 ARM MCU Windows %%4: | Eclipse JT &k Zif%

2.5.

2.5.1.

2-31. Build ARM I#258

3eclipse-warkspaae-Prﬂ‘ect/Application,’main.c-Ec\ipse IDE - . = n - =10k
Fle Edit Source Refactor Navigate Search Project Run Window Help
] 52 [®@- & -B BB oS @ - & - -G H-0-QL-L-®5 5~ s wid - - R R
Q e
¥ Project Explorer &1 = O [ mainc & =0 oxr % =
=) <,3|) 7 8 499 int main(void) i CA R
€ project (in Eclips 70
4> Project (in Eclips 51 systick_config(); ° %
> 4 Binaries 52 gd_eval_led init(LED2); g
. ) Includes 53 pd_eval led_init(LED3);
1= = gd eval led init({LED4); U gd32M10,
> i Application gd_eval led init(LEDS); U gd32f10
[y CMSIS ul systickh
3 Debu: while(1){ .
% Debug /* turn on led2, turn off leds */ U stdioh
> Gy Doc gd_eval_led_on(LEDZ); ] o mainfvoi
s g Ld gd_eval_led_off(LEDS);
> [y Peripherals delay_ims(1@@e);
< * turn on led3, turn off led2
’ ey Startup gd_eval_led_on(LED3); il
G, Utlities . T Th o aorcrienn . . -
2! Problems & Tasks B Console 32 [ Properties SN~ =

CDT Build Console [Projeci]

make --no-print-directory post-build
arm-none-eabi-objcopy -0 binary "Project.elf” "Project.bin”; arm-none-eabi-objdump -D "Project.elf” >
"Project.dump”

Invoking: GNU Arm Cross Create Flash Image
arm-none-eabi-objcopy -0 ihex "Project.elf” "Project.hex”
Finished building: Project.hex

Inunking: GNU Arm Cross Print Size
arm-none-eabi-size --format=berkeley "Project.elf”
text  data bss dec hex filename

1392 12 2@a8a 3434 d9c Pr‘DjE(t.Elf
Finished building: Project.siz

16:14:37 Build Finished. @ errors, ® warnings. (tock 17s.428ms)

Writable Smart Insert 13:1:347 R

fEF J-Link T EHRTE

Debug it & 7 1H

e, A diRun->Debug Configurations, i ADebugffit & 5 i .
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A 2-32. #t A\ Debug Configurations 51

= colipse-workspace - Project/Application/main.c - Eclipse IDE
File Edit Source Refactor Navigate Search Project Window Help
i g | ® - % v o El ‘% L1 | 5 @ = c?.._’ Run Last Launched Ctrl+F11
3%, Debug Last Launched F11
5 Project Explorer 2 = 8  [g mainc & @8- Profile Last Launched
2% Y 8 fg_ int main(voi Profile History 3
4 5 Project (in Eclipse_project) ;‘: { systick Profile As 4
45 Binaries 52 gd_eval | Profile Configurations...
> mil Includes 5‘3 BS_EVai_ :
» G Application ;; gd_::ZI_ HinjListany i’
> By CMSIS 55 — @ RunAs »
" 57 while(1) Run Configurations...
(= Debug i PR g
* (g Doc 59 gd_e Debug History 3
» Gy Ld 66 gd_e N
> [z Peripherals 61 d.ela -
62 /* 4 Debug Configurations...
> [y Startup 63 gd_d
» ¢y Utilities T = A Breakpoint Types »
[ Problems & T4 © Toggle Breakpoint Ctrl+Shift+B
CDT Build Console [f © Teggle Line Breakpoint
" Toggle Watchpoint
make --no-print-d Toggle Method Breakpaint
arm-none-eabi-obj . .
"Project.dump” @ Skip All Breakpoints Ctrl+Alt+B
Remave All Breakpoints
Invoking: GNU Arm
arm-nene-eabi-obj| @ External Tools 3
Einichad hiilding

f# F1J-Link GDBServerCL{E NGDB Server, ffHGCCIT. H##+ IGDBI E{F NGDB Client.

A diGDB SEGGER J-Link Debugging, #i#d—2J-Link ific & & .

2.5.2. Main &3E

2-33. GDB SEGGER J-Link Debugging-Main #i-&

= Debug Configurations

Create, manage, and run configurations

€3 [Debuggerl: Device name?

P e E x| B Y~ Mame: Project Debug

type filter text 2 Main| % Debugger| b+ Startup | & Source [] Comman| . SVD Path

[€] C/C++ Application o Project:

[E] C/C++ Attach to Application

[E] C/C++ Container Launcher Project

[E] C/C++ Postmortem Debugge I C/C++ Application:

[€] C/C++ Remote Application Debug\Project.clf

Cii C/C++ Unit

[E] GDB Hardware Debugging Variables... l [Search Projed..‘l [ Browse... ] 5

[€] GDB OpenOCD Debugging Build (if required) before launching

[£] GDB PyOCD Debugging

[£] GDB QEMU Debugging Build Configuration: |Select Automatically ']
4[c] GDB S.EGGER J-Link Debuggir ® Enable auto build () Disable auto build

[€] Project Debug @ Use workspace settings Configure Workspace Setfings... ||
A Launch Group =

4| 11 3

Filter matched 13 of 13 items

TEMainiE IR A, EFEN0 L, — RS NS LE T Melfxcff:. wmigkF, mblbd
Browse, FEhisinelf s 1.
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R WERZHIg PR T 2T, B S AT AT SO elf e Dy T 7, ] DU 1Y
ST —EDebugfIiL E .

2.5.3. Debugger % &

7EDebuggeri iK1, S Hbrits i 85 Device name, A1 AGD32F107VC.

HEE R Eclipse A 5 O IEFIRC B J-Link#42, X B A3, R ATA IEMRE,
Al {EExecutable pathf%, i%H1J-Link GDBServerCL 144X} #6545

ER: HEMOHRS, 2R E K J-Link 3Kz b A5 .

& 2-34. GDB SEGGER J-Link Debugging-Debugger %5
= Debug Configu_ratinns o

Create, manage, and run configurations . .i?
¥ ¢ R | =T MName: Project Debug
type filter text [ Main %5 Debugger| b Startup % Source [ Common| %, SVD Path
[T] C/C++ Application J-Link GDB Server Setup =
[E] C/C++ Attach to Application Start the J-Link GDB server locally [T Connect to running target

[T] CfC++ Container Launcher

[E] C/C++ Postmortem Debugge Executable path:  ${jlink_path}/${jlink_gdbserver} Browse... | |Variables...
[T] CfC++ Remote Application Actual executable: D:\Program Files\SEGGER\JLink/)LinkGDBEServerCL.exe

mn

Cif C/C++ Unit DR e BE T OF ol kepace preterences pages or the project properties page)
[t ] GDB Hardware Debugging . X
. Device name: GDSEFlD?Vq Supported device names
[©] GDB OpenOCD Debugging
[T] GDB PyOCD Debugging Endianness: @ Little ) Big
[©] GDB QEMU Debugging Connection: @ UsB (@) 0] (USB serial or IP namefaddress)
4 [c] GDB SEGGER J-Link Debuggir Interface: @ SWD ) ITAG
[] Project Debug . . S
Initial speed: @ Auto () Adaptive @ Fixed 1000  kHz
i Launch Group
GDB port: 2331
SWO port: 2332 [¥] Verify downloads [¥]Initialize registers on start
Telnet port: 2333 [¥] Local host only [ Silent =
[ (T d
Revert Appl
Filter matched 13 of 13 items [ e ] [ BEY, ]
':?:‘ I Debug l l Close l

2.5.4. SVD Path &3k

7ESVD Pathik i, &+ H AR v frf iISVD LAt .
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2.6.

2.6.1.

& 2-35. GDB SEGGER J-Link Debugging-SVD Path % HiF

FoEX BT~

type filter text
] C/C++ Application
[©] CfC++ Attach to Application
€] C/C++ Container Launcher
[©] C/C++ Postmortem Debugge
[©] CfC++ Remote Application
Cif C/C++ Unit
[ ] GDB Hardware Debugging
[©] GDB OpenOCD Debugging
[t] GDB PyOCD Debugging
[©] GDB QEMU Debugging

4 [c] GDB SEGGER J-Link Debuggir

[€] Project Debug

i Launch Group

< 1 2

Name: Project Debug

[ Main %% Debugger | I+ Startup | i Source | [T] Common | T, SVD Path
SVD file (used by the peripheral reqi_sters viewer: may be .svd.zip)

IFile path: Fheclipse-workspace\GD32F10x_Firmware_Library_V2.2.1\GD32F10x_CL.svd llBrﬂwse...I Variables...

= Debug Configurations l B
Create, manage, and run configurations . @

Filter matched 13 of 13 items [ Revert I [ dpely ]
'::3\," [ Debug ] [ Close ]
- M A Y
£/ GD-Link TR TE
Debug B & 510
—he 2 gy \ . N
AT, fdiRun->Debug Configurations, #E A\ Debugfit & 71 .
& 2-36. #t A\ Debug Configurations 518
= colipse-workspace - Project/Application/main.c - Eclipse IDE
File Edit Source Refactor Navigate Search Project Window Help
i g | ® - % v o El % -] | 5 @ = (.?_’ Run Last Launched Ctrl+F11
3%, Debug Last Launched F11
5 Project Explorer 2 = 8  [g mainc & e
2% Y 8 fg_ int main(voi Profile History 3
4 F:ojer:t (in Eclipse_project] ;‘: { systick | Profile As »
» 3%, Binaries 52 gd_eval | Profile Configurations...
> mil Includes ?3 gg_evai_
A 54 gd_eval | Run Histo »
» G Application 55 gd_eval | v
> By CMSIS 55 @ RunAs »
» = Debug 37 while(1}) Run Configurations...
* (g Doc 59 gd_e Debug History 3
» Gy Ld 60 gd_e N
> [z Peripherals 61 dela :
52 /* 4 Debug Configurations...
> [y Startup 63 gd_d
» ¢y Utilities T = A Breakpoint Types »
[ Problems & T4 © Toggle Breakpoint Ctrl+Shift+B
CDT Build Console [f © Teggle Line Breakpoint
Toggle Watchpoint
make --no-print-d Toggle Method Breakpaint
arm-none-eabi-obj . .
"Project.dump” @ Skip All Breakpoints Ctrl+Alt+B
Remave All Breakpoints
Invoking: GNU Arm
arm-nene-eabi-obj| @ External Tools 3
Einichad hiilding

f# FHOpenOCD{E NGDB Server, f#HGCCT. A%+ 1)GDB 1. A{FAGDB Client. X{i;GDB
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2.6.2.

2.6.3.

OpenOCD Debugging, #%—20penOCD 1AL & ik i .

Main &I+
& 2-37. GDB OpenOCD Debugging-Main %+

L —
‘= Debug Configurations ‘ - - - p -

Create, manage, and run configurations

FeoRX B Y-

type filter text

Mame: Project Debug (1)

[E] Main | %% Debugger| B Startup £ Source| [[] Comman| %, SVD Path
[€] C/C++ Application
[E] C/C++ Attach to Application
[€] C/C++ Container Launcher Project
[€] C/C++ Postmortem Debugger C/C++ Application:
[€] C/C++ Remote Application
Cii C/C++ Unit
[©] GDB Hardware Debugging Variables... ] ’Search Project...l ’ Browse... ]
a[t] GDB OpenOCD Debugging
[€] Project Debug (1)
[£] GDB PyOCD Debugging Build Configuration: |Select Automatically v]
[£] GDB QEMU Debugging

Project:

Debug'\Project.elf

Build (if required) before launching

() Enable auto build () Disable auto build

a[c] GDB SEGGER J-Link Debugging ® Use workspace settings .

[€] Project_RISCV Debug

[€] Project Debug

& Launch Group

4| T Y
Filter matched 15 of 16 items Revert Apply
'(?3. [ Debug l ’ Close ]

EMainig TR, YT TR, — RS a3 INSEr LR el xcfF. wREs, bl bd
Browse, F3hinelf ot

HE: WRZATGRE T 2, T BB N AT S elfe T 58, Al DL
SHH i —EDebugft & .

Debugger £+

FEFA E Eclipse R 15 O IE#IC B OpenOCD 4%, ix Bl [ ZhiH. tn 2w kA LA E
1] 7EExecutable path#%, &+ OpenOCD14ax} 1%

1£Config options#= H, IHE {4 I ficfg 3. Al H -
-f ${eclipse_home}\eclipse_toolchain\OpenOCD\scripts\target\openocd_gdlink_gd32f10x.cfg

OpenOCD#jcfg - H At 1 il &s PR H AR iR b H ARt iR 5 ke 55505 B .
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& 2-38. GDB OpenOCD Debugging-Debugger £ F£

[c] C/C++ Application

[£] C/C++ Attach to Application
[£] C/C++ Container Launcher

[£] C/C++ Postmortem Debugger
[t] C/C++ Remote Application

Cif C/C++ Unit

[c] GDB Hardware Debugging

4 [c] GDB SEGGER J-Link Debugging
Project_RISCV Debug

OpenOCD Setup

Start OpenOCD locally

Executable path:

Actual executable: E\eclipse\\eclipse_toolchain\OpenOCD\bin/openocd.exe

${openocd_path}/${openocd_executable}

Variables...

Tio change It use the Qlobal or workepace preferences pages or the project properties page)

[Cnnﬁg options:

-f $eclip se_hnme)\aclipse_tm olchain\OpenOCD\scripts\target\openocd_gdlink_gd32f10x.cfg I -

S —— .
‘= Debug Configurations ‘ - - - - -_— L@g
Create, manage, and run configurations .
i HeRX BY - Name: Project Debug (1)
type filter text [ Main | % Debugger| > Startup | %~ Source| =] Common | &, SVD Path

. GDB port: 3333 =
4[] GDB OpenOCD Debugging =
[c] Project Debug (1) Telnet port: 4444
[c] GDB PyOCD Debugging Tl ez 6666
[c] GDB QEMU Debugging

2.6.4.

Project Debug

@ Launch Group Allocate console for OpenOCD Allocate console for the telnet connection

GDB Client Setup
Start GDB session

Executable name:  ${cross_prefixtgdb${cross_suffix}

Actual executable: arm-none-eabi-gdb

Filter matched 15 of 16 items [ Revert I [ Apply I
@ [Coeee J [oes ]

SVD Path £+

T1ESVD Pathi& ik, i&# BHArCGH FrRs SvDX /.

2-39. GDB OpenOCD Debugging-SVD Path &£

= Debug Configurations

Create, manage, and run configurations

i E e B x' B Y~ MName: Project Debug (1)
type filter text [El Main | %% Debugger | B+ Startup | K Source | [] Common |2, SVD Path
[E] C/C++ Application -

SVD file (used by the peripheral registers viewer; may be .svd.zip)
[E] C/C++ Attach to Application

[€] C/C++ Container Launcher
[E] C/C++ Postmaortem Debugge|=
[E] C/C++ Remote Application
Cif C/C++ Unit
[£] GDB Hardware Debugging
4 [t] GDB OpenOCD Debugging
[] Project Debug (1)
[£] GDE PyOCD Debugging

File path: F\eclipse-workspace\GD32F10x_Firmware Library V2.2.1\GD32F10x CL.s

ariables...

o AMD ACKALL Rabumnins

a | 1 3

Filter matched 15 of 16 items l Revert ] [ Apply I
@ | Debug |[ close |

2.7. Debug 71

Debug Configurationstit & 5¢ %5, sidiDebug, # ADebugti&l.
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& 2-40. # A\ Debug &1

T s O T
= Debug Configurations

E et

Create, manage, and run configurations

i Iﬁ 0 = x' =) l? M Name: Project Debug

C/C++ Application

C/C++ Attach to Applicatic

C/C++ Container Launche

C/C++ Postmortem Debug

C/C++ Remote Applicatiol Load Symbols and Executable

type filter text [E] Main | %5 Debugger | = Startup | & Source| (] Common | &, SVD Path

Cii C/C++ Unit Load symbals
GDB Hardware Debugging @ Use project binary: Project.elf =
Proj Ty: 4} E
GDE O 0OCD Deb in _ E
pen = L!ggln_ @) Use file: Workspace... | | File System...
GDB PyOCD Debugging
GDB QEMU Debugging Symbols offset (hex): A
4 [c| GDB SEGGER J-Link Debug Load executable
[c] Project Debug @ Use project binary:  Project.elf
& Launch Group i
() Use file: Workspace... | | File System...
Executable offset (hex):
Ll . 1l e
4 m | »
Revert Appl
Filter matched 13 of 13 items ’ ] ’ BB ]
@' [ Debug "’ Close

14 2 Debughi & .

2-41. 3# A\ Debug ¥ & -2

= Confirm Perspective Switch

S

suspends.

Switch to this perspective?

[T Remember my decision

This kind of launch is configured to open the Debug perspective when it

This Debug perspective supports application debugging by providing views
for displaying the debug stack, variables and breakpoints.

Switch

No
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K| 2-42. Debug 1. &

= eclipse-workspace - Project/Application/main.c - Ediese IDE

Brr = O
BES T §
4775 Project (in £
>3 Binaries
> ) Includes
> G Applicati

. Gp CMSIS

» @& Debug

. G Doc

> G Ld

> G Peripher
> G Startup
G Utilities

Fle Edit Source Refactor Navigate Search Project Run Window Help
milhd | B:B:i%is| 0 m M 2@ 0l

‘i‘s_bo Hr O QU@ ED -

%5 Debug 2
4[] Project Debug [GDB SEGGER J-Link Debugging]
4 2 Projectelf
4 P Thread #1 57005 (Suspended : Breakpoint)
= main() at main.c:51 0x30003f4
s JLinkGDBServerCLexe

w| arm-none-eabi-gdb
s Semihosting and SWV

44 main function
[in] none
[out] none
none

int main(void)

systick config();
gd_eval_led_init(LEDZ);
gd_eval led init(LED3);|
gd_eval_led_init(LED4);
gd eval led init(LEDS);
while(1){
/* turn on led2, turn off leds */
gd_eval_led_on(LED2);
R P S TP
]
B Console 52 ¥} Registers [£] Problems {3 Executables B} Debugger Console [J Memory
Project Debug [GDB SEGGER J-Link Debugging]
SEGGER J-Link GDB Server V7.54b Command Line Version

JLinkARM.d11 V7.54b (DLL compiled Sep 14 2021 16:11:45)

!

[ b

m

Command line: -if swd -device GD32F167VC -endian little -speed 1088 -port 2331 -swoport 2332 -telnetport 2333 -vd -ir -localhostonly 1 -

----- GDB Server start settings
GDBInit file:

GDB Server Listening port:

SHO raw output listening port:
Terminal 1/0 port:

Accept remote cennection:
Generate logfile:

Verify download:

Init regs on start:

Silent mode:

nane

2331

2332

2333

localhost enly
off

en

en

off

Single run mode: on
Target connection timeout: @ ms
------ J-Link related settings------
J-Link Host interface: uss
J-Link script: none
J-Link settings file: nene
------ Target related settings------
Target device:
Target interface: SwWD
Tarost intarfars snesd- 1080k

4 [ LR ([} 3

53:28:2172 R

Writable Smart Insert

2.7.1. TERA4H

: resume&igizfT

: suspend#{%

_J} terminateil 4

el

=l: stepinto

=¥ . step over

: step out
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B
il reset

2.7.2. Registers & 0

ESEHAL, YEFEWindow->Show view->Registersit 1, 7B 7] 255 i FH 2F 77 25 O 1H

& 2-43. 3T Registers H 1

I= eclipse-workspace - Project/Application/main.c - Eclipse IDE

1 i |
File Edit Source Refactor MNavigate Search Project Rul{[Window] 'elp

o~ | & 2% e |mnmsd D |- New Window L-®s 5 - P v &l v
Editor 3
e [T]0 3 Debug 2 Appearance ' El | i
5 5 W &  4[c]Project Debug [GDB SEGGER J-Link Debu I Show View I » | 8 Breakpoints Alt+5Shift+Q, B
475 Project (in 4 (7 Project.elf Perspective v | B Conscle Alt+5Shift+Q, C
>ii'? Binaries 4 @ Thread #1 57005 (Suspended : Brea o 45 Debug
Includ = main() at main.c:51 0x80003f4 [rgeiten i’
> [l Includes _ = = G} Debugger Console
> G Applicati h':. JLmI-cGDBSer\.:rCI;Exe Preferences & Debug Sources
CMSIS - arm-none-eabi-
s o= ¢ == Disassembly
> = Debug . \ . i
[ mainc ¥ [E] main( at main.c:51 0x80003f4 &1 Error Log Alt+Shift+Q, L
> 2y Doc _ - -
s G Ld 47 ~ hretval none 0 Executables
Y.
> 7y Peripher = int main(void) G Expressions
> [y Startup . . 0 Memory
e systick config();
> 7y Utilities gd_eval led init(LED2); @ Memory Browser
gd_eval_led init(LED3); B, Modules
gd_eval led init(LED4); o . .
gd eval led init(LED5); g5 Cutline Alt+Shift+Q, O
%, Peripherals
while(1){ = .
/* turn on led2, turn off leds =/ [#]  Problems Alt+Shift+Q, X
gd_eval_led_on(LEDZ); =g Progress

gd_eval_led_off(LEDS);

7 Project Explorer
4 [
|
B Console i 1} Registers [2 Problems (3 Executables G} Debugge: S Signals
Project Debug [GDB SEGGER J-Link Debugging]

B2 Templates
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2.7.3.

& 2-44. Registers & M

Name

rl0
rll
rl2

i1t Registers i3

psp
primask
basepri
faultmask

rontrnl

By e
Value

0xB000000 (Hex) 1
OxB000000 (Hex)
Oxa0000000 (Hex)
OxB8000175 (Hex)
Ox2000060c (Hex)
0x20000664 (Hex)
Ox20000664 (Hex)
(hed 8400440 (Hex)
O0x183690 (Hex)
1436 (Hex)
0x2180634 (Hex)
0x40902612 (Hex)
0x20000390 (Hex)
Ox20002000 (Hex)
0xB00022f (Hex)
0xB0003f4 (Hex)
OxG61000000 (Hex)
Ol (Hex)
0x3b5b260 (Hex)
Ox (Hex)

Ox (Hex)

(e (Hex)
n

200

= 0

Peripherals & 1

TESEEARS, 1 FEWindow->Show view->Peripheralsit i, 7T B0 7 F 5 27 47 2% 14E -

2-45. ITFF Peripherals & 0

= eclipse-workspace - Project/Application/main.c - Eclipse IDE 0
- p—
File Edit Source Refactor Mavigate Search Project Rul Window l—lelp
o~ | & 2% e nmd. N New Window PR Ne=R - 5~
Editor 3
fypiz = O 4% Debug &2 = | i Sbpsaincs i’ =
= G W &  a[c] Praject Debug [GDB SEGGER J-Link Debu Show View } | ® Breakpoints Alt+Shift+Q, B
475 Project (in £ 4 [ Project.elf Perspective v | B Console Alt+Shift+Q, C
’i‘:? Binaries 4 uS“)lhrea?i #1 5?'0[.?5 (Suspended : Brea Navigation , #{r Debug
> @) Includes ' .= main() at main.c:51 0x80003f4 B Debugger Console
> Gy Applicati wi| JLinkGDBServerCLexe Preferences @ Debug Sources
» Fg CMSIS s arm-none-eabi-gdb pikar e
> (= Debug p Semihosting and SWV o 5 - 4
v rror Lo t+Shift+
@1 Error Log Alt+Shift+Q, L
* [y Doc i e _
- G Ld e 7 {2 Executables
> ¢ Peripher 1512 g &1 Expressions
> gy Startup 1818 g 0 Memory
> ¢y Utilities 1819 ¢10 0 Memory Browser
i ril B, Modules
B r12 5= Outline Alt+Shift+Q, O
it sp (=, Peripherals
sl Ir Problems Alt+Shift+Q, X
1o1n c
st P =y Progress
1o1n
uIeT XPSE f5  Project Explorer
i msp .
1Y Renisters
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2.7.4.

& 2-46. Peripherals &0

()= Variables g Breakpoints €7 Expressions B4 Modules % Peripherals 22 g
Peripheral Address Description -
[[] 5, ENET_PTP 0x40028700  Ethernet: Precision time protocol
[ &, EXMC (xA0000000  External memory contraller
[ &, EXTI (40010400  External interrupt/event controller
[ 2, FMC 0x40022000  FMC =
[ %, PWDGT 0x40003000  Free watchdog timer
T, GPIOA 0x40010800  General-purpose 1/Os
[, GPIOB x40010C00  General-purpose 1/Os
[, GPIOC Ox40011000
[l %._ GPIOD Ox40011400
[l %._ GPIOE 0=40011800
[l %._ GPIOF Ox40011C00
= 8 ~snrmue M ANAA 3NN i
Mo details to display for the current selection.
le 0 Memory &3 I TP ="|| Ul g~ § = 8
L GPIOA: 0x40010800 22 | 9 New Renderings..
Register Address Value it
a %_ GPIOA Ox40010800
a0 CTLO 040010800 0x00000000
2 MDo [L:0] 0x0
& cTLo [3:2] 0x0
2 MD1 [5:4] x0
8 T [7:6] 0x0
8 MD2 [9:8] 0x0
£ cTz2 [11:10] x0 i
2 MD3 [13:12] 0x0 r
8 T3 [15:14] 0x0
8 MDa [17:16] 0x0
8 cTLa [19:18] Ox0
2 MD5 [21:20] )
8 CcTLs [23:22] 0x0
2 MD6 [25:24] 0x0
2 CT6 [27:26] 0x0
8 MD7 [29:28] 0x0 ~
e cT7 [31:30] 0x0
L1 CTL Dx40010804 000000000
. e ISTAT 0x40010808 0x00000000
Memory & X

FESEHEL, % “Window->Show View->Memory”, fidiMemory s [ 75+ 5, aJ LLTIF

Xt [ty Memoryi it o
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GigaDevice
& 2-47. $TH Memory & O
n fWindow | Help
1 Mew Window Q- 5~ 2 v
Editor 3
Appearance | = B  ®-Variab.. % Break.. &7 Expre..
ke [ k| @5 Breakpoints Alt+Shift+Q, B
Perspective # | E Console Alt+Shift+Q, C
:3-{ Mavigation k P
G} Debugger Console
Preferences £ | Debug Sources
=25 [Disassembly
&1 Error Log Alk+Shift+Q, L
i) Executables
" Expressions
0 Memory
” Memory Browser
B Madulss
& 2-48. Memory & M
E Console [* Problems (2 Executables B} Debugger Console [0 Memory 2
Monitors & ¥ |0x40022010 : 0x40022010 <Hex= &2 ]4} New Renderings...
@ 00022010 Address 0-3 4-7 8-B C-F
40022010 00000000 00000000  FCFFFFO3
40022020  FFFFFFFF 00000000 00000000 00000000
40022030 00000000 00000000 00000000 00000000
40022040 00000000 00000000 00000000 00000000
40022050 30000000 00000000 00000000 00000000
A0 I0A0 DTttt OO OO0 LY
2.7.5. Expressions &

TESCEARS, P “Window->Show View->Expressions”, siiiExpressions I “+"5, A L)
N TINFN A A B AR =
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& 2-49. ITJHF Expressions & H

Rurd | Window |JHelp

lﬁf|i‘= MNew Window Q-&5 4 'Tl‘}uv‘ifi"vl
Editor r
Appearance | ® B = Variables % Breakpoints &' E
FLink: E‘l Show View l b | @ Breakpoints Alk+Shift+Q, B
Perspective » | Bl Console Alt+Shift+Q, C
nded :
ke Mavigation » # | Debug
¥ : ! Debugger Conscle
t
=( a Preferences B Debug Sources
071 Ovsoooess |7 bl
000426 == Disassembly
&1 Error Log Alt+Shift+Q, L
' >
el systick.c &5 1 F’“ Expressions I
0 Memory

@ Memory Browser

& 2-50. Expressions & O

(*)= Variables ®g Breakpointd Y Expressions 2§ Modules = O
R R sl

Expression Type Value

)= delay volatile uint32_t 993
b Add new expressio

R : Ecplise A A 7EAURS 5 1L AT IRPIRZS T 4 7T LLEE % A28 & (KOMEL, 27 I JE 32 S B8 A8 & (ML

2.7.6. RICHE 1
1EIER T B A% FEInstruction Stepping Modei% 4, TSI & .
2-51. T RICHE N
= ~ |I,,';¢E%&|Eluﬁ- @L-—f?#.lu:v.. ..|@l’¢'0'%'

ERICHE T, TR, TTEB TSR %
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2.7.7.

A 2-52. RiC4%mE D

E eclipse-workspace - Project/Application/main.c - Eclipse IDE

File Edit Source Refactor MNavigate Search Project Run Window Help

mifhg |@ 2 %ia|nmdz®.n PCIE R R R X v Bletacd G-
Q
9 Pr.. 822 = O 4% Debug 2 = § = 0 ®-Vara. % Break.. 97 Expre.. Bi Modul.. =¥ Disass
B G 7 §  4[c] Project Debug [GDB SEGGER J-Link Debugging] Enter location here .| & &
> =5 Project (in Eclips 4 ¥ Project.elf & main:
4 % Thread #1 57005 (Suspended : Breakpoint) 03080374: push . £r3, i"}()
— . . 51 systick_confi H
Simaintstimsin e, 00003 osecoste: bl owsepsacd <systick_config»
pei JLinkGDBServerCLexe 52 gd eval led init(LEDZ);
po arm-none-eabi-gdb $Fazeeesfa: movs roe,
5 . . @30083Tc: bl @xB8008190 <gd_eval led_init>
vl Semihosting and SWV 53 gd_eval led init(LED3);
03680400 : movs r@g, #1
230004082 : bl exB8000190 <gd_eval led init>
[€] main.c 22 [g] systick.c [E] main() st ma... g = g 54 gd_eval_led_init(LED4);
systick_config(); - 08668406 : mov's re, #2
gd_eval_led_init(LED2); A3600488: bl ax3880198 <gd_eval led init>
gd_eval led init(LED3); 55 gd_eval_led_init(LEDS);
gd_eval_led init(LED4); aseaadac: movS ra, #
gd_eval_led _init(LED5); 0366040 : bl ox3000190 <gd_eval_led_init>
59 gd_eval_led_on(LED2);
while(1){ A 03680412: movs ra, #
J* turn on led2, turn off leds */ I 23688414: bl Bx80801cE <gd_eval_led_on>
gd_eval_led_on(LEDZ); 68 gd_eval_led off(LEDS);

Bt} Debug 1. &

Je s IRV A, P deC/CH+, BITTHEN TR
2-53. B! Debug L&

= Cipse-workspace - Project/Application/systickc - Eclipse IDE
File Edit Source Refactor Navigate Saagch Project Run  Window Help
- | BiD % | o TRRBFPEI|SF OISO Br-fl-ore-o- |

Q s
Fypr. 2 = O 3% Debug B = | i# § = B (- Variables % Breakpoints @7 Expressions i Bi Modules
= % 7 § a[g] Project Debug [GDB SEGGER J-Link Debugging] - % |9 ot
43S Project (in Eclips 4 i Projectelf Expression Type Value
. 4% Binaries 4 P Thread #1 57005 (Suspended : Breakpoint) 10- delay volstile uiné32.¢ T

delay_decrement( at systick.c:83 0x30004b0 E
<signal handler called=( at Oxfffffffo
delay_1ms() at systick.c:71 0x80004a4

> 5! Includes
4 Application
g gd32f10x

45 Add new expressio

> [ main.c = main at main.c:61 0x8000426

> [ systick.c s JLinkGDBServerCLexe o
’ G CMSIS Bimzie [Emsrizos Dot = =B
» (= Debug 78 paramfout] none pr
o Doc 79 al  none
- o Ll /
G Peripheral “void delay_decrement(void)
3 eripherals
Gy Startup if (BU 1= delay){
> Gy Utilities delay--3

} L
A
I »
G Console 52 I#] Problems (3 Executables Gl Debugger Console [ Memory = | "BE-fr= 0

Project Debug [GDB SEGGER J-Link Debugging]
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3. SAIE LR

Bropr e TREAL, HnT HE: 'S N O Eclipse T2 . fEE 542, 55 5 File->Import, & #%
General->Exisiting Projects into Workspace & A\ &\ L%, ridi“Next’.

B 3-1. FAIA LE-1
= Import E@ﬂ

Select
. . . H
Create new projects from an archive file or directory. H

Select an import wizard:

pe filter text s

IJ = General I

E Archive File

|. % Existing Projects into Workspace

y [ File System

| ] Preferences

[} Projects from Folder or Archive

I s = CfC++

> = Git

> = Install H
| > = OComph

» = RPM

» = Run/Debug

T [

»

m

3 _ — -
@ = Back MNext = Finish

L

P COH LR 4%, Eclipsesx R A HiZ 2 T IFTA LI, EEMENE TR, A&
“Finish”, BIa] S NBA L.
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A 3-2. SABAILHE-2

= Import

|

Import Projects

Select a directory to search for existing Eclipse projects.

@ Select root directory:
(7 Select archive file:

Projects:

F:\eclipse-workspace\GD32F10x_Firmware_Library V2.2.1\Template[li4 Browse...

[N

Browse...

Options

[[]search for nested projects

[[] Copy projects into workspace

[[JClose newly imported projects upon completion
[[Hide projects that already exist in the workspace

Working sets

[ Add project to working sets

Project (F\eclipse-workspace\GD32F10x_Firmware_Library_V2.2.1\Template\Eclipse_proje Select All

»

Deselect All

i

Select...

Next = [ Finish ]

Cancel
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4.

£ RAM i

APRL: BRI, s s T L
& 4-1. 7£ RAM F1RAE I1d 324 memory map

[ memory map */

NEMORY

{
FLASH (rxz) : ORIGIN = 0xZ0000000, LENGTH = BE
R&N Carw) : ORIGIN = 0xZ0002000, LENGTH = BE

!

W2 B R EE AL EISRAM. SE G IR VRS BR2 )5 B dm e THE .

nvic_vector_table_set(NVIC_VECTTAB_RAM, 0);

4-2. £ RAM H A BB ER

L

[in] none
[out] none
none

=] "

E

W ca

= int main(wvoid)

{l
nvic_vector_table set(NVIC_VECTTAB_RAM, @); l
[

gd_eval led init(LED2)

gd_eval led init(LED3)

gd_eval led init(LED4);
:I .

gd_eval led init(LED5);|

&

¥
¥

L0 T T Y Y Y SR A A L =Y
W5 I N Y S T =)

=] 7

raba 1o f 1% T

5 U%3: {EDebug Configurations->Startupi£ T+, “ZJi%ERAM application.
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A 4-3. £ RAM FiFi&} Debug Configurations

[ ==

i - .
‘Debug Configurations - - r—

Create, manage, and run configurations

F & B x| =Y - Name: Project Debug

* Main | %5 Debugger | b+ Startup | & Source| [T] Common| &, SVD Path
[€] C/C++ Application Initialization Commands i
[€] C/C++ Attach to Applicat []Initial Reset and Halt Type: Low speed: 1000 kHz
[E] C/C++ Container Launche ) ) )
[E] C/C++ Postmortem Debt JTAG/SWD Speed: @ Auto (0) Adaptive () Fixed kHz
[€] C/C++ Remote Applicatic Enable flash breakpoints
Cif C/C++ Unit Enable semihosting Conscle routed to: [V Telnet [[| GDB client
[€] GDB Hardware Debuggir [¥]Enable SWO CPU freq: 0 Hz. SWO freq: 0 Hz. Port mask: Ox1
[€] GDB OpenOCD Debuggit
[€] GDB PyOCD Debugging 1
[£] GDB QEMU Debugging
4[] GDB SEGGER J-Link Debu LE

[] Project Debug

& Launch Group Load Symbols and Executable

[¥] Load symbols

@ Use project binary: Project.elf

() Use file: Workspace... | | File System...
Symbols offset (hex):

Load executable
@ Use project binary:  Project.elf

() Use file: Workspace... | | File System...

Executable offset (hex):

Runtime Options

RAM application (reload after each reset/restart)

Run/Restart Commands

[F] Pra-run/Ractart racat Tunar (alwave avaritad at Ractart
4 11 | +

< | [ | +
Revert Apply

Filter matched 13 of 13 items

©)

[ Debug ] I Clase

HBRA: HEARAM R {1 Debug L, Wi K.
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Al 4-4. 76 RAM HifiRF Debug L

2 cclipse-workspace - Project/Application/main.c - Eclipse IDE =
File Edit Source Refactor Navigate Search Project Run Window Help
o | ®iBi%mie|pnmezee|lE 0 Sit-0- - ®S 5~ b~ S~ oo~
Q B BHE
Eypr. 32 = 8 AF Debug H = § = B -Varia. % Brea.. @7 Expr.. B\ Modu.. # = 8
5 % W &  4[E] Project Debug [GDB SEGGER J-Link Debugging] Enter location here - | & 8
415 Project (in Eclip 4 1 Project.elf 3 main: -
» 4 Binaries a @ Thread #1 57005 (Suspended : Breakpoint) 4 2?9993f41 | push - EPL :f‘}”
¥ e o systick_config();
> & Includes _ (S.main0 at main.c:51 0x200003f4 200003F6: bl Bx26ABB4ES <systick configr
> [ Application pol JUnkGDBServerCLexe 52 gd_eval_led_init(LED2);
[ CMSIS ] arm-none-eabi-gdb 2epe03Ta: movs re, #9
“ sermihasti 4 SWv 208083fc: bl @x28860198 <gd_eval led_init>
(= Debug w Semihosting an 53 gd_eval_led init(LED3); E
> [ Doc 26000400 : movs ré, #1
gy Ld 26000402 bl . ?xi@:@?l?@((gdijvalilediinib
- . 54 gd_eval_led init(LED4);
|52 gd32f10x [€]0x80003f2  [€] mainc & = B ooooane:  movs rB, 43
» (G Peripherals systick_config(); - 20008488: bl @x26060198 <gd_eval led_init>
. G Startup gd_eval led_init(LEDZ); 55 gd_eval_led_init(LEDS);
s gd_eval _led 2600040¢ ; movs r@, #3
(i Utlities gd_eval led 2060848 bl 8x%26000198 <gd_eval_led_init>
gd_eval led_init(LEDS); 59 gd_eval_led_on(LEDZ);
20000412 movs ré, #8
while(1){ 260066414 bl @x208081c8 <gd_eval led_on>
/* turn on led2, turn off leds */ 60 gd_eval_led_off(LEDS);
gd_eval_led on(LED2); 20000418 : mows r@, #3
gd_eval_led_off(LED5); 26066415 bl @x208001e8 <gd_eval led_off>
delay_1ms(1@88); 61 delay_lms(leea);
/* turn on led3, turn off led2 */ 2088841e; mov.w r@, #leee ; 8x3ed =il
A enrml lad amfi RV i mnmnnaan L1 AemAnAna—A cdiTo aeos
] b 4 b
B Conscle 3 [2] Problems (3 Executables &} Debugger Console [ Memory =
Project Debug [GDB SEGGER J-Link Debugging]
R2 = 22824813, Rl = 02220022, R2Z = EQRREGR8, R3 = E@BREDRR
» s RE > 48488448
R8 = B@18569@, R9 = @BAC1436, R1@= @2138634, R1l= 48902612
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5. £ printf $TED
5.1. PR
HIRL: W hnsyscall.c3C A, KR EInGn T _write bR #5E .
int _write(int file, char *ptr, int len)
{
int Dataldx;
for (Dataldx = 0; Dataldx < len; Dataldx++)
{
__io_putchar( *ptr++);
}
return len;
}
HIR2: ¥usart®E M F]__io_putcharifi % .
int __io_putchar(int ch)
{
usart_data_transmit(EVAL_COMO, (uint8_t) ch);
while(RESET == usart_flag_get(EVAL_COMO, USART_FLAG_TBE))X{
I3
return ch;
}
HUR3: f FprintfeR £, BIATIERFTED,
printf("Running led test!\r\n");
5.2. TENE R BIERCE

FTENVF S BEiC B . 78 T2 Properties->C/C++ Build->Settings->Tool Settings->GNU Arm
Cross C Linker->Miscellaneous /4] i-u _prinft_floatiZ i .
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& 5-1. FTENE REIRRE

S Properties for Pruiect E@ﬂ
X | Settings

> Resource

Builders ) -
I 4 C/C++ Build Configuration: ’Debug [ Active ]

Build Variables

Environment

| »

'l [Manﬁge Canfigurz

caaing ¥ Tool Settings | 3 Toolchains | ‘M Devices | [ container Settingsl 4 Build Stepsl
Settings
. (%2 Target Processar Linker flags (-Xlinker [option]) & 0 ¢
Tool Chain Editt =y A
(22 Optimization
» CfC++ General - .
i (2 Warnings
Linux Tools Path ¥ Debugdi
. MCU (22 Debugging
i 4 %) GNU Arm Cross Assembler
Project Matures (8 Preprocessor
Project References (2 Includes
Run/Debug Settinc - .
k . (22 Warnings
Task Repository (# Miscellaneous
Task Tags = I
4 GMNU Arm C C G i .
> Validation ® rm ross & mempRer Other objects £ #) |E
o (%2 Preprocessor
WikiText (# Includes
(#5 Optimization
(2 Warnings
# Miscellaneous
4 B3 GNU Arm Cross C Linker
(# General
& |ibraries )
(2 Miscellaneous
- TR CrosE Create Flash Image | Oenerate map "${BuildArtifactFileBaseNz
(22 General [T Cross reference (-Xlinker --cref)
4 i3 GNU Arm Cross Print Size [] Print link map (-Xlinker --print-map)
T .
(%2 General Use newlib-nano (--specs=nana.specs)
se tloat with nano printt (-u _printt_tloat,
V| Use fl ith printf (-u _printf_float) I
se Tloat with nano scant (-u _scani_float)
[CTUse 1l h Lil¢ _tloat)
Do not use syscalls (--specs=nosys.specs)
[[Verbose (-v)
Other linker flags -
P T — 4 T} | 3
® [Apply and Close] ’ Cancel l

HER: 1 Hprintfis] FZAEFTENF N AR AN, %l printf("Running led test\r\n"). 2.
TEGCCH i i printf 2 K KH Inf i f¥size, & %tcodesized K/NERIB & 13 &, AHERE
{5 H printf.
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6. ENyEd
K61, [REFE
R A5 3% H#

1.0

Bk A A

2021411 H 30 H
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This document, including any
product of the Company described in this document (the “Product”), is owned by the Company under the intellectual property laws and
treaties of the People’s Republic of China and other jurisdictions worldwide. The Company reserves all rights under such laws and
treaties and does not grant any license under its patents, copyrights, trademarks, or other intellectual property rights. The names and

brands of third party referred thereto (if any) are the property of their respective owner and referred to for identification purposes only.

The Company makes no warranty of any kind, express or implied, with regard to this document or any Product, including, but not
limited to, the implied warranties of merchantability and fitness for a particular purpose. The Company does not assume any liability
arising out of the application or use of any Product described in this document. Any information provided in this document is provided
only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality
and safety of any application made of this information and any resulting product. Except for customized products which has been
expressly identified in the applicable agreement, the Products are designed, developed, and/or manufactured for ordinary business,
industrial, personal, and/or household applications only. The Products are not designed, intended, or authorized for use as components
in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, atomic energy control
instruments, combustion control instruments, airplane or spaceship instruments, transportation instruments, traffic signal instruments,
life-support devices or systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution
control or hazardous substances management, or other uses where the failure of the device or Product could cause personal injury,
death, property or environmental damage ("Unintended Uses"). Customers shall take any and all actions to ensure using and selling
the Products in accordance with the applicable laws and regulations. The Company is not liable, in whole or in part, and customers
shall and hereby do release the Company as well as it's suppliers and/or distributors from any claim, damage, or other liability arising
from or related to all Unintended Uses of the Products. Customers shall indemnify and hold the Company as well as it's suppliers
and/or distributors harmless from and against all claims, costs, damages, and other liabilities, including claims for personal injury or

death, arising from or related to any Unintended Uses of the Products.

Information in this document is provided solely in connection with the Products. The Company reserves the right to make changes,

corrections, modifications or improvements to this document and Products and services described herein at any time, without notice.

© 2021 GigaDevice — All rights reserved
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